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Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation was 
published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.

Date Description

September 10, 2012 Updated “Qualified Hardware and Operating Systems” on page 6.

September 4, 2012 Updated “Shared Storage Support” on page 20 and “Documentation 
Changes” on page 30 topic.

http://www.avid.com/support/downloads
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 
that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/readme
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
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New in Media Composer v6.5, Symphony v6.5, and 
NewsCutter v10.5

For information on new features, see the What’s New pdf. 

AMA Plug-ins

Just a reminder that only the AMA QuickTime Plug-in is included with your Avid editing 
application. All other AMA Plug-ins are downloaded and installed separately. See 
www.avid.com/ama.

Audio Device Drivers

For a listing of currently supported Audio device drivers, see  
http://avid.force.com/pkb/articles/en_US/Download/en379411

Before Installing the Editing Application

Read through the Installation Guide for Avid Editing Applications. This document is available on 
the Knowledge Base.

n (Windows) Note for Administrators: You must give the user the right to “raise thread priority.” 
This must be done within the Domain Group Policy by giving the right explicitly to the user or 
giving the right to a group and adding the user to that group.You will not be able to launch as a 
regular user if this is not set properly.

Download Note: To avoid “File Path too long” or a “File cannot be copied” warning while 
unzipping the downloaded installer, try placing the installer .zip on the root level of your C:\ 
drive and unzip it from that location.

Notes on Macintosh OS

The Avid editing application Macintosh installer switches to 64-bit. Please make sure that your 
Macintosh system supports 64-bit prior to installing and that your current non-Avid applications 
are compatible to run in 64-bit mode.

Notes on Windows 7 OS

Note the following topics if you are running the editing application on the Windows 7 OS.

http://www.avid.com/US/products/Avid-Media-Access
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Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop 
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once 
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings. 

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time 
you launch the editing application.

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and log 
back in as a Standard user, if necessary. 

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 4GB of RAM. Some features might require 
more RAM and specific hardware. See “Feature Performance” on page 21 for more info.
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Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 21 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the 
Open IO Frequently Asked Questions document on the Knowledge Base: 
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware 
the qualified Operating Systems are:

• Windows 7 64-bit SP1(Professional)

• (Media Composer and Symphony) Macintosh Lion v10.7.1, v10.7.2, v10.7.3, v10.7.4, 
Mountain Lion v10.8, v10.8.1

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are 
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able 
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or 
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most 
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:

1. Click on your system drive (Macintosh HD in most cases) to highlight.

2. From the File menu select Get Info (cmd+I)

3. Click the lock icon in the bottom right to make changes

4. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege 
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

n If you repair permissions on the system drive, they will reset and you will have to repeat this 
procedure.

http://avid.force.com/pkb/articles/en_US/faq/en422991
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Macintosh v10.8 and AVCHD

If you are working with AVCHD and have Macintosh v10.8 (Mountain Lion) OS installed in 
your system, the AVCHD folder will appear as a QuickTime icon. You can perform a Link to 
Volume the same as you did when working with Macintosh v10.7, just note that the folder 
appears as a QuickTime icon. When performing a Link to File, you must right+click the AVCHD 
QuickTime icon and select Show Package Contents. Then you can see the BDV folder. Right 
+click the BDV folder and select Show Package Contents. Then you can see the files needed to 
perform an AMA Link to File.

Qualified PC Workstations with Avid Media Composer, Avid Symphony, 
and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and NewsCutter v10 and higher.

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 

Lenovo ThinkStation 
E31, "Intel Xeon 
E3-1245V2 3.40 GHz 
8 GB DDR3-1600 
RAM

NVIDIA Quadro 600 
graphics adapter or 
integrated Intel HD 
Graphics P4000

Windows 7 64-bit Software Only

HP z800 Dual 6 Core, 
2.66 GHz 

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z800 Dual Quad 
Core, 2.93 GHz or 
2.66GHz

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single 6 Core 
3.33 GHz

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single Quad 
Core, 3.06 GHz or 2.93 
GHz

NVIDIA
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z210 Quad Core 
Xeon 3.3- E3-1240, 3.4 
E3-1270, 3.5 E3-1280

Quadro 600 Windows 7 64-bit Software Only
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HP z200 Intel® Core™ 
i5-660 3.33 4MB/1333 
Dual-Core

NVIDIA 
Quadro 600

Windows 7 64-bit Software Only

Dell™ T5500 Dual 6 
Core, 2.66GHz

NVIDIA
Quadro FX 4800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5500 Dual, 
2.93GHz Quad Core

NVIDIA 
Quadro FX 4800 
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 6 
Core, 3.2GHz 

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 
Quad Core, 2.93GHz 

NVIDIA
Quadro FX 3800 
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw8600 Dual Quad 
Core, 3.0 GHz

NVIDIA 
Quadro FX 3700 

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5400 Dual Quad 
Core, 2.5 GHz or 3.15 
GHz

NVIDIA 
Quadro 3700

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw4600 Core 2 
Duo, 3.0 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Dell T3400 Core 2 Duo, 
2.33GHz,or 2.66 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 
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Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and 
Avid NewsCutter

The following PC Notebooks are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and Avid NewsCutter v10 and higher. The following applies to the 
editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

• Playback in full quality 10 bit mode is not supported

Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Lenovo ThinkPad W530
"Intel Core i7-3720QM 2.6 
GHz, i7-2820QM 2.7Ghz, 
i7-3920XM 2.9GHz 

"NVIDIA Quadro 
K1000M or 
K2000M 

Windows 7 64-bit Software Only

HP 8760w i7-282Q, 
i7-2820Q 2.2 or 2.3 GHz

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

HP 8560w, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only

Dell M6600, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

Dell 4600, i7-2720Q, 2820Q, 
2.2 or 2.3 GHz
15” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only
Mojo DX

HP 8740w X820, X920 
Quad i7 (1.73, 2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8540w X720, X820 
Quad i7 (1.6, 1.73 GHz)

15" 1920x1080

NVIDIA FX
1800M

Windows 7 64-bit Software Only
Mojo DX
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Qualified Macintosh Workstations for Avid Media Composer and Avid 
Symphony

The following Macintosh Workstations are qualified with the Avid Media Composer v6 and Avid 
Symphony v6 and higher. Mac Pro systems ship with the 64-bit kernel enabled. In previous 
releases, you had to toggle to the 32-bit kernel. With v6 and higher, you must run with the 64-bit 
enabled.

Dell M6500 i- 820Q, 
i7-840Q, i7-920X(1.73, 1.87, 
2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8730 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

HP 8530 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 770M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Dell 6400 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Mac Pro “Westmere” 
Two 2.66GHz 6-Core 
Intel Xeon (12 cores) 

ATI Radeon HD 5770 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
2.66 GHz or 2.93 GHz 
Dual Quad Core Intel 
Xeon 

NVIDIA GeForce 
GT 120

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
Dual 2.26 GHz Quad 
Core Intel

NVIDIA GeForce GT 
120

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only
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Qualified Macintosh Notebooks for Media Composer and Avid Symphony

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

Mac Pro “Harpertown” 
Dual Quad Core 3.0 or 
3.2 GHz

NVIDIA GeForce 
8800 GT

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only
Nitris DX
Mojo DX

iMac 27” Display Quad 
Core 3.4 GHz

ATI 6970M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

iMac 27” Display Quad 
Core 2.93 GHz

ATI 4850 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

iMac 21.5” Display 
Dual Core 3.6GHz

GeForce 9400 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

iMac 27” Display 
2.8 GHz 4 GB Quad 
Core 1066MHz

ATI Radeon HD 4850 
Graphics Processor

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

iMac 27” Display Quad 
Core 2.8GHz

ATI 4850 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

iMac 20” Display 
2.66 GHz Core 2 Duo

GeForce 9400 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, Mountain 
Lion v10.8, v10.8.1

Software Only

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With
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Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

MacBook Air 13” 
1.7GHz Dual-Core Intel Core i5 
or 
1.8GHz Dual-Core Intel Core i7

Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only

MacBook Pro 17" 
2.2/2.3/ GHz Quad Core i7

6750M
Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only

MacBook Pro 15" 
2.0/2.2/2.3GHz Quad Core i7

6490M
6750M
Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only

MacBook Pro 15" 
2.53GHz Dual Core i5
15” or 17” 2.66GHz Dual Core i7

GT 330M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only
17” only - Mojo DX (no 
DNxHD capture)

MacBook Pro 15” or 17” 
2.53/2.66/2.8 GHz Core 2 Duo

 9400M and 9600M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only
Mojo DX (no DNxHD capture)

MacBook Pro 15” and 17” 
2.5 GHz Core 2 Duo

 8600M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, 
Mountain Lion 
v10.8, v10.8.1

Software Only
Mojo DX (no DNxHD capture)
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Compatibility Chart

The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows Media™, 
Avid Interplay®, shared storage, Sony® XDCAM™, Panasonic® P2, and Pro Tools LE® versions 
that were qualified with the Avid editing applications. Also listed are the third-party applications 
such as Boris Continuum Complete, Avid DVD by Sonic™, and Sorenson Squeeze®that ship with 
the editing applications. 

Item Versions Comments

QuickTime Support v7.7.2 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

NVIDIA Driver 
Support

v275.89 See Setting up the NVIDIA Card.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on 
page 20.

Sony XDCAM 
driver

v2.13 (XDCAM Transfer for 
Macintosh)

Win 7-64 FAM 2.3.2 and VFAM 
3.1.1

The VFAM firmware version is 2.45. The 
driver can be downloaded from Sony's 
website http://esupport.sony.com/.

Panasonic P2 drive (Macintosh) No device support 
for Lion

(Windows 7) Driver version for 
P2 devices:v2.16

There is currently no P2 writeback 
support for Macintosh clients.

Avid FX v6.0.4 (Windows)

v6.0.4 (Macintosh)

Ships with:
Avid Media Composer
Avid Symphony 

Avid Artist Series 
(Euphonix)

EuControl software v2.5.7 or later See the User’s Guide for information on 
Artist Series Color setup information.

http://www.microsoft.com/en/us/default.aspx
http://esupport.sony.com/
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Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

n IMPORTANT:Co-install of the Media Composer and Pro Tools is currently not supported if your 
operating system is Macintosh v0SX v10.8 (Mountain Lion).

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must select 
the first uninstall option — “Pro Tools Only” — which is not selected by default.

• (Macintosh only) When you uninstall your Avid editing application, you must uninstall just 
the application and not the audio drivers or Pro Tools no longer sees the devices. When you 
start the Avid Uninstaller, deselect the options to uninstall AvidCoreRuntime.pkg and 
AvidDIORuntime.pkg.

• Mojo SDI will not be supported with Media Composer, but can still be connected in a 
co-install configuration for use with Pro Tools.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application (Media Composer and NewsCutter).

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Avid Mbox 2 Family Audio Devices

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
Symphony 
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install
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Other Avid Audio Devices

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only — Media Composer and NewsCutter)

• Command|8

• Avid Artist Control

• Avid Artist Mix

• Avid Artist Transport

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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• Avid Artist Color

• JL Cooper MCS-3000X MIDI automation controller

• JL Cooper FaderMaster Pro MIDI automation controller

• Yamaha® 01V/96 and Yamaha 01V digital mixing console

n The JL Cooper controllers and Yamaha mixing consoles do not support automation pan 
recording.

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No
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The following table compares supported third-party external controllers and mixers.

For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V

Control surface for transport 
controls and other functions

No No No

Provides audio play, input, and 
output

No No No

Record automation gain Yes Yes Yes

Record automation pan No No No

Flying faders No Yes Yes

Touch-sensitive faders No Yes No

Solo/mute Yes Yes Yesa

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time

Supports audio mixing No No Yes

Latch mode (also known as 
Snap mode)

No Yes No

Number of fader steps of 
accuracy

128 1024 256
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Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. This version of the 
editing application requires the following Nvidia Driver:v275.89 

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder 
that installs with your Avid application.
Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set Desktop Video Editing Mode:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the menu bar, select Desktop. Enable Desktop>Video Editing Mode.

3. Click Apply.

To set the Prefer Maximum Performance mode and Global Settings:

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

3. Set Global presets to Base profile. 
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4. In the Global Settings tab, change Power Management mode to Prefer Maximum 
Performance.

5. Click Apply.

6. Set the Global preset to 3D App-Video Editing.

7. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following. 

There is no support for ethernet attached clients in a MediaNetwork environment.

Editing 
Application 
Operating 
System

ISIS 
5000 
Client

ISIS 
5000 
Server

ISIS 7000 
Client

ISIS 7000 
Server

Media-
Network 
Client

Media-
Network 
Server

Windows 7 64-bit  v3.5, 
v4.0

v3.2, 
v4.0

v3.5, v4.0  v2.4. v4.0 v5.4 v5.1.3

Macintosh Lion 
v10.7.3

v3.5, 
v.4.0

v3.2, 
v4.0

 v3.5, v4.0  v2.4., v4.0 v5.5.1  v5.1.3
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. 

Feature Description Recommended System

J2K Capture • HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• Dell T5500 Dual 6 Core with 
Hyperthreading On 

• Mac Pro Dual 6 Core “Westmere”

Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual 6 Core “Westmere”

XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”
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HD RGB HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage. (The HP z800 
and the Dell T5500 have been 
qualified to successfully play 
back 2 streams with PIP and 
Color Correction effects. The Mac 
Pro Dual Quad Core “Nahalem” 
successfully plays back 2 streams 
with PIP.)

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

• Storage: 10Gb Ethernet ISIS, 

AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance.

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance. 

Recommendation of qualified systems 
depends on your planned use of this 
feature. Heavy usage of highly 
compressed codecs requires the high end 
systems. 

Ancillary Data Ancillary Data and Nitris DX: 
Due to software DNxHD codec 
performance requirements, you 
must have a dual quad core 
system in order to capture 
DNxHD 220 or 220x with 
ancillary data on the Nitris DX 
platform. 

Dual Quad Core or dual 6-core Systems

DVCPro HD capture You will get better performance 
with a dual quad core or dual 
6-core system.

Dual Quad Core or dual 6-core Systems

Feature Description Recommended System
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AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

• HP z800 Dual Quad Core or Dual 6 
Core, with Hyperthreading On - 
64-bit OS

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

Four Stream Playback:

• HP z800 Dual 6 Core with 
Hyperthreading On - 64-bit OS

• Mac Pro Dual 6 Core “Westmere”

Two Stream Playback:

• HP z400, single 6 Core with 
Hyperthreading On

Single Stream Playback:

• Systems listed above.

• HP z400, single 4-core with 
Hyperthreading On

• HP 8600, dual 4-core without 
Hyperthreading On

• HP 8740w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• HP 8540w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• Dell Precision M6500 laptop, i7 (2.00 
GHz) 4-core with Hyperthreading On

• The MacBook Pro 17" laptop, i7 (2.66 
GHz) 2-core with Hyperthreading On

• iMac 27", i7 (2.8GHz) 4-core with 
Hyperthreading On

Feature Description Recommended System
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Limitations

The following limitations apply to the current version of the editing application.

Avid Artist Color

➤ Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist 
Color with your Avid editing application, including the following:

• HSL Shift Layer: all soft keys

• HSL Bank 2 Shift Layer: all soft keys

• Curves: F8 and F9 soft keys

• Curves Shift: F1, F3, F6, and F9 soft keys

• Secondary: F2, F7, F8, and F9 soft keys

• Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

➤ Bug Number: UDevC00158145. When you use the Artist Color controller to perform color 
corrections, the Avid editing application might show some degradation of performance when 
safe color warnings are displayed. If you turn on safe color warnings and then perform a color 
correction, you might notice that the movement of the cursor becomes uneven. 

Workaround:  If you experience slower or uneven performance, turn safe color warnings off 
before you perform your color corrections.

➤ Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist 
Color to enter Color Correction mode the first time after start your Avid editing application. Any 
parameter update will draw them.

Workaround:  When you make any change in a parameter in the Color Correction tool, the 
color wheels appear.

➤ Bug Number: UDevC00157413. Currently only the Master controls for the Hue Offset and the 
Controls tabs of the HSL Group in the Color Correction tool are mapped to controls on the Artist 
Color controller. Hue Offset and Control parameter controls for Shadow, Midtones, and 
Highlights, as well as the Luma curves are not mapped. You must use the Color Correction tool 
to adjust these controls.
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➤ Bug Number: UDevC00156948.  (The F2 soft key (Next HSL Subtab) does not function until 
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the 
Artist Color surface before you apply a color correction, you get a system beep and the subtab 
does not change.

➤ Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see 
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and 
then use the right trackball to shuttle, and then move either the left or the center trackball, you 
might see the other trackballs now control the right monitor.

➤ Bug Number: UDevC00158145. You might notice slower or uneven performance when making 
color corrections with safe color warnings turned on.

Workaround:  Click one of the Actions buttons in the Safe Color Settings dialog box, and select 
Ignore to turn safe color warning off.

➤ Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the 
Artist Color or with the mouse, incorrect color correction values might display in parameter 
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround:  Adjust any parameter. The correct values display in the Color Correction tool.

➤ Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open 
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON 
device, you must open the EuControl application by clicking the EUCON icon in the dock, and 
then selecting Window > EuControl Settings.

Compatibility

➤ Bug Number: UDevC00166431. You might receive AMPI Subsystem errors when launching 
the editing application. Avid recommends that you refer to the following Knowledge Base article 
for information on possible causes.
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091

➤ Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your 
system in order to play linked AMA clips from the MediaNetwork shared storage.

➤ Bug Number: . The Standalone Transfer Manager will be supported with this release, except for 
compatibility with Airspeed Classic and Open I/O devices.

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091
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Effects

➤ Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest 
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1 
effects will automatically be promoted to AVX2:

• Avid Pan & Zoom

• Region Stabilize

• RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will 
automatically be promoted to new corresponding AVX2 effects. These effects will not be 
recognized by earlier versions of Media Composer.

➤ Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for 
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and 
selecting one of the pan value options. However, if you want to manipulate pan control points 
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display 
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel 
for any audio track and select a pan value option.

Interplay

➤ Bug Number: UDevC00169286. The Active Format Description (AFD) bin column value does 
not consistently check-in to Interplay when a sequence is checked-in.

➤ Interplay v.2.5 support for native HD 23.976p and HD 24p formats now includes their associated 
proxy resolutions. For more information refer to the Avid Interplay Best Practices Guide.

➤ Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires 
pulldown. Therefore, you can only use it with clips where the media has been acquired at the 
native frame rate (without pulldown).

➤ Bug Number: . (Interplay) Pro Res formats can only be used by Avid editing applications that 
are in a non-Interplay environment. For any additional limitations regarding running an Avid 
editing application in an Interplay environment, see the Interplay ReadMe.

➤ Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer 
on Avid editor after first install. After an initial installation of the editor and Interplay support 
software, the editing application may fail to locate the Media Indexer. This can happen if some of 
the Avid Service Framework services have not started correctly.
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Workaround:  Open the Workgroup Properties tool on the editor and check whether any of the 
services are not running. Restart any services as required. Then restart the Avid editing 
application again. You may have to do this the first few times that you start the editor. After a few 
times the services will begin starting automatically, even after a reboot.

Mixed Frame Rates

➤ Bug Number: UDevC00172465. After modifying a sequence across frame rates, you might see 
variations in clip durations that result in out of sync issues across tracks (for example, sync off by 
1 or 2 frames). This is due to calculations required for crossing frame rates that might result in 
roundoff errors. Therefore if you experience these sync issues after modifying a sequence across 
frame rates, you might need to go into trim mode and make adjustments. Also keep in mind that 
round-tripping the sequence back to its original rate will not necessarily restore it to its original 
exact contents.

Media Tool

➤ Bug Number: UDevC00164836. If the Media Tool window is set to Frame view, you might 
experience slow redraw issues when accessing large volumes of shared storage.

Output

➤ You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for 
1080p projects or when you are in Stereoscopic mode.

Workaround:  When in stereoscopic mode or have True Progressive output set for 1080p 
projects, the down-convert and cross-convert options are not available. To output at a rate 
different than the project format, go to the Format tab and change the output project setting.

PhraseFind

➤ Bug Number: UDevC00166649. For best results with PhraseFind, Avid recommends using 
Avid certified storage solution.

Play

➤ Bug Number: UDevC00164987. After editing for an extended period of time, using the 
keyboard arrow keys to single step through the sequence might skip frames or move in the wrong 
direction. 
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Workaround:   Minimize and maximize the editing application or change focus to another 
application and then back to the editor.

➤ Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its 
source elements is too long to be played” error if you have a sequence over 12 hours.

QuickTime

➤ Bug Number: UDevC00159820. QuickTime Reference movies are not supported by 
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are 
also not supported in QuickTime version 7.6.9 on Windows.

Stereoscopic 3D

➤ A software developer's kit is now available for 3rd-party partners who would like to build AMA 
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences 
compatible with Avid Media Composer or Symphony. This developer's kit is available on the 
Avid website.

➤ 720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party 
vendors.

➤ Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you 
may get the wrong scaling and cropping of lines.

➤ Stereoscopic projects are not supported on Avid Interplay.

➤ Multicam of stereoscopic clips is not supported. 

➤ NVIDIA 3D Vision

• Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D 
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully 
tested.

• Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows 
system.

• Due to an NVIDIA driver issue, the first time that the full screen play window appears, the 
application will resize to a single monitor. Resize the application as necessary. You can reset 
your window positions by clicking on a toolset in the menu.

➤ Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in 
full stereoscopic format.
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Timeline

➤ Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have 
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing. 

Workaround:  Hold Cmd + . to stop the waveform from drawing. 

User Interface

➤ Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or 
Record monitors. To enter timecode in the monitors, select the monitor and then type in the 
appropriate timecode values.

➤ Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes. 
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For 
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe) 
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of 
Keyframe B, Keyframe A now displays the higher volume level.

➤ Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source 
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is 
still selected, although the action of loading the group clip actually causes the Avid editing 
application to enter Source/Record mode. If you play back the clip, you only see the linecut and 
cannot perform MultiCamera edits.

Workaround:  To turn off the Multicamera mode display, select Special > Multicamera Mode, 
and make sure MultiCamera Mode is not selected.

➤ Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title 
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out, 
the progress bar displaying the status of the render operation does not update and the application 
appears to become unresponsive. However, even though the progress bar does not advance, the 
rendering operation continues. When it completes, the progress bar closes.
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Documentation Changes

The following documentation changes were made after the initial documentation release was 
finalized. These will be corrected in the next release of the product.

Committing Assets to an Export Volume

In the What’s New for v6.5, the topic “Committing Assets to To an Export Volume” should have 
stated that once you commit the assets, the sequence is flattened to the OP1b format, the video is 
encoded to the codec set in the selected shim and audio saved as PCM. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,077,604; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 
5,754,180; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 
5,986,584; 5,987,501; 6,016,152; 6,018,337; 6,023,531; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,130,676; 
6,134,607; 6,141,691; 6,198,477; 6,201,531; 6,223,211; 6,249,280; 6,269,195; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 
6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 6,546,190; 6,552,731; 
6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 6,747,705; 
6,763,134; 6,766,063; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187; 
7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; RE40,107; 7,403,561; 7,433,519; 7,512,885; 7,545,957; D352,278; 
D392,267; D392,268; D392,269; D395,291; D396,853; D398,912. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0515031; 0635188; 
0674414; 0694243; 0705517; 0752174; 0857293; 0976108; 0988756; 1068723; 1068734; 1111910; 1173850; 1629675. 
Other patents are pending.
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